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P Category - Update History 
 
Following is a brief list of all the major changes that have taken place over the years in the Perfect Lite minor 
road lighting (P Category) software. 

P CATEGORY LIGHTING (PlePcat) 

VERSION  3.07  (Released April 2012) 
� Minor internal changes to enhance performance 
� Additional graphics added to the Help 

 
VERSION  3.06  (Released October 2011) 

� Upcast Angle field now also included on Spacing Calculation menu screen allowing easier in-run 
changes to the upcast angle 

� When opening a new i-table the Flux value is set to zero 
� ‘Close’ button on results display now made the default 
� When opening a new i-table file the ‘Flux’ value is set to zero 
� 'Lamp Wattage and Type' field now optional (not displayed on output, if blank) 
� Input i-table filename can be up to 150 characters long 
� Better handles resetting of default printer, if changed 
� Width of 'Multi File' mode selection screen increased 
� 'Upcast' angle range changed to -5 to 45 
� Minor screen and output formatting changes 

 
VERSION  3.05  (Released June 2011) 

� Compatible with 32bit and 64bit Windows PC operating systems (including Windows 7) 
� Program screen can now be moved, re-sized, minimized etc. 
� Compatible with amendments in 2008 and 2010 to AS/NZS  1158.3.1 & AS/NZS  1158.2 including:- 

         a)  reduced lumens for Australia - P4 & P5 
         b)  reduced lumens for New Zealand - P3(NZ), P3R(NZ), P4, P4R(NZ) & P5 
         c)  changed values in lower part table 2.6 adjusted 

� Category P5, P6, P7 & P8 removed from Pathway Category selection 
� User Defined Category selection enhanced to be able to assign all relevant LTPs 
� T5, CFL & LED light types added to luminaire description screen 
� Descriptive error messages added in the calculation of UWLR 
� When calculating UWLR, allows one to specify a range of angles & also gives DLOR & ULOR 
� Checks input CIE file contains CR/LF characters 
� Minor formatting changes on input and output screens 

 
VERSION  3.04  (Released October 2008) 

� Corrects problem reading an i-table file where an intensity value is greater than 999 cd/m2 

VERSION  3.03  (Released November 2007) 
� Check box for the New Zealand reduced LTPs has been replaced by Category P3R & P4R on the 

Category selection drop down list box 
� Additional check box & input fields added to allow input of variable user defined Light Technical 

Parameters 
� Checks Read/Write access is available to the user to allow program to operate correctly 
� Lengthy Path/File names for the selected luminaire is suitably wrapped on result screens & printed 

output 

VERSION  3.02  (Released September 2006) 
� Categories P5 to P8 able to be selected for Pathways 
� Displays on the Luminaire Description form the de-rating factor if HPS or LPS previously selected 
� Job Name field added to Local Area Roads and Pathways form 
� Allows mounting heights down to 0.5m for Local Roads (any Upcast angle) 
� Allows mounting heights down to 0.5m for Pathways (Upcast angle must be zero) eg. used for 

Bollards 
� Range of allowable Offset values increased between -12m and +30m to -20m and +40m 
� Check box added to select whether to include the light contribution from adjacent luminaires to the 



PlePcat	-	Update	History	 Page	2 of 6	

span being investigated 

VERSION  3.01  (Released November 2005 - Special version for Sylvania Lighting Australasia only) 
� Menu item ‘Luminaire Classification Report’ replaced by ‘Luminaire Intensity Report’ to display 

intensity values at specific angles in order to derive the Luminaire Classification Type 
� Foreground and Background colours on some screens have been changed 
� Shows the respective maximum ‘Maintenance Factor’ opposite the ‘Ingress Protection Rating’ field 
� ‘Luminaire Classification’ field removed from the Luminaire Description input screen 

VERSION  3.00  (Released July 2005) 
� With the introduction of AS/NZS 1158.3.1:2005 the PlePAL program has been superseded by the P 

Category Lighting software (PlePcat) 
� ‘Miscellaneous’ menu renamed to ‘Tools’ menu and ‘Options’ item added 
� Setting the company name has moved to the ‘Options’ menu 
� ‘Options’ menu now includes a new item called ‘Output setup’ which is used to set the margin width, 

font name & size for all output to the printer 
� When ‘Multi File Mode’ is activated a small tick will be shown against it in the ‘File’ menu.  To exist 

‘Multi File Mode’ simply select the item when it is ticked 
� Maintenance factor calculation form has been changed to also include the ‘IP Rating’ and a ‘Lamp 

Depreciation factor’ 
� Luminaire Description form now includes fields for the Light Source and Luminaire Classification 
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PEDESTRIAN AREA LIGHTING (PlePAL)             [Now Superceded] 

VERSION  2.06  (Released June 2004) 
� “Multi File Mode” added which allows the automatic processing of up to 200 I-table files against a 

single set of layout parameters 
� Due to access problems associated with Network security the configuration files (Plepal-user.cfg) is 

now stored in the same folder as the program (NOT root folder of C drive) 
� Warning message is given if the Printer used for output is changed from the default printer 
� Program version/Date stamp on bottom of printouts has been modified slightly 
� Contact email address on ‘About’ screen changed 

VERSION  2.05  (Released May 2003) 
� Released with Perfect Lite - Version 4.86a 
� ‘Save As…’ button added to the screen where all results are viewed.  This allows you to save or 

append the results to a text file rather than printing them. 
� Progress bar added to the Local Road and Pathways calculation screen. 
� Allows Category P1 & P2 for Local road calculations (ignores Vertical illuminance). 
� Now validates the Company name against the serial no. of the software. 
� Contact details changed on the ‘About’ screen 
� Calculation of Luminaire Classification corrected. 
� Note about compliance after ‘5 November 2001’ removed as no longer applicable. 

VERSION  2.04  (Released May 2001) 
� Released with Perfect Lite - Version 4.84 
� When ‘tabbing’ between input fields the whole field is highlighted so if you want to change the whole 

field you simply start typing the new value rather than first erasing all previous text.  If you want to 
just change part of the field then press the <End> key and the highlight will disappear and you can 
move the cursor back to what you want to change data. 

� Initialisation file (“.ini”) now referred to as a Configuration file (“.cfg”) 

VERSION  2.03b  (Released October 2000) 
� For Local Roads and an Opposite arrangement the program now allows the luminaire Offset to 

exceed half the Road Reserve width - this will simulate a Central arrangement. 

VERSION  2.03a  (Released August 2000) 
� The bug has been fixed where program could not be re-started and restored to full size if closed (or 

the PC shutdown) when it is minimised. 

VERSION  2.03  (Released May 2000) 
� A field description on the Path Spacing Table input screen has been changed from ‘Distance from 

Path Edge’ to ‘Offset from Path Edge’.  This is to remove any confusion as to what the distance 
represents - see associated help screen. 

� ‘&’ character can now be used in ‘Offset Distance’ and ‘Offset from Path Edge’ field to nominate the 
luminaire position as halfway across road reserve or path.  Compliments the ‘*’ character for one 
quarter across road reserve/path already built into the software. 

� A history of revisions to the software added to the Contents item on the Help menu. 
� When selecting ‘Open an I-table’ from the menu, the ‘I-Table File Name’ field has been changed to 

a drop down list box allowing the selection of the file name from one previously used. 

VERSION  2.02  (Released February 2000) 
� When selecting ‘Open an I-table’ from the menu, the first input screen has been changed to only 

select the required file name.  On the subsequent screen where you would normally input the 
description you now also input the flux, maintenance factor and upcast angle. 

� Save the values entered for ‘Luminaire Description’, ‘Lamp Wattage and Type’ and ‘Stores Code’ 
against the file name so it will be automatically displayed next time the same luminaire is used. 

� Check box added to allow all the LTP’s at maximum spacings to be displayed on a separate page 
of the Spacing Table. 

� Check box added to allow all the display of illuminance values at grid points of each maximum on 
separate pages of the Spacing Table. 

� The location of the PLEPAL program window on the display screen will now be restored to where it 
was located last time the program closed down. 

� Luminaire Classification changed to show if it complies after 5 November 2001. 
� A ‘Back’ button has been added to some screens & position of the ‘Next’ and ‘Back’ buttons 
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swapped around on other screens. 

VERSION  2.00  (Released November 1999) 
� Released as a result of the revision to the Australian and New Zealand Public Lighting code 

AS/NZS 1158.3.1:1999 where lighting category ‘P’ was introduced. 
� The program has been converted to a 32 bit Windows Application and the name changed to 

Perfect Lite - Pedestrian Area Lighting (PlePAL.exe).  The previous MS-DOS versions (1.60, 1.59 
etc.) was known as the Spacing Graph Generator for Minor Roads (PleSpace.exe). 
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SPACING GRAPH GENERATOR (PleSpace)             [Now Superceded] 
(DOS based version for the previous Category B & C roads) 

VERSION  1.63 (Released May 2001) 
� Released with Perfect Lite Version 4.84 
� Modified to do all printing through the Windows Print Manager 
� Menu added at start of program to select printer for output 
� With the introduction of AS/NZS 1158.3.1:1999 the PLESPACE program has effectively been 

superseded by the Pedestrian Area Lighting software (PLEPAL). 

VERSION  1.60  (Released June 1998) 
� Released with Perfect Lite Version 4.82 
� Allows the specification of a full Path for an I-Table file 
� Standard DOS file dialogue used for file selection 
� For Mode 3 - A maintenance factor of up to 10 can be used for R-Table ‘0’ to calculate Lux rather 

than Cd/m2 

VERSION  1.59  (Released April 1997) 
� Released with Perfect Lite Version 4.81 
� Road Width changed to go from 2m through to 40m 
� Now uses version 1.60 of PPD.EXE for printer output 

VERSION  1.58 
� Special issue for SEQEB/Energex in Queensland 
� Rounding off of displayed results corrected 
� 'Count' column removed 
� 'Plot' & 'Redraw' option removed from graphics screen 
� Error message given if 'PPD.EXE' file not found prior to printing 
� Printer port displayed after printer description on opening screen 
� Spacing range increased to 120m on graph/plot 
� Road reserve width increased to 38m on graph/plot 
� Default Upcast angle set to 5 degrees 
� Reading default set up values from file ‘PLESPACE.TBL’ added 
� Reading from file PLESPACE.LIN now fully supported 
� Maximum spacing displayed to 1 decimal place 
� 'Emax/Eav' displayed to 1 decimal place 
� 'NO COMPLIANCE' added if Maximum spacing less than 0.005m 
� <F5> key added to select from Parameter table file 
� If PLE.HLP not found then PLESPACE.HLP used 

VERSION  1.57  (Released July 1995) 
� Message window displayed if 0 cd/m2 found at V=0 in I-table - "/ADJ" command line option added 

to adjust values to 1 cd/m2 
� "DESCRIPTION=" line added to 'PLESPACE.INI' file 
� Disables MOUSE if file 'MOUSE.NO' found 

VERSION  1.56 
� Text 'AS1158.1 -1986' added 
� Display/Print out fixed so when NOT complying spacing 'Eav','Emin','Emax/Eav' shows last actual 

calculated values NOT last "complying" values 
� Version no. added to text results screen/print out 

VERSION  1.55 
� Now uses version 1.42 of PPD.EXE 
� <Esc> used to abort processing of PrintGL print out 
� Colour argument of 'PSET' & 'LINE' made Long Integer 
� Configuration file now "PLE48.INI" 

VERSION  1.54 
� Draws vertical ordinate at nominated values as in file "PLESPACE.LIN" 
� Rounding off corrected to be same as print out 

VERSION  1.53 
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� ‘Opposite’ arrangement re-instated as maximum now determined using both lights 

VERSION  1.52 
� '/FULL' command line option added for detailed calculation output to file 
� Now support large asymmetrical I-table files 
� Problem fixed in calculating Eh behind light 
� ‘Opposite’ arrangement removed till Finding maximum is done properly 
� Undocumented '/GRID' command line option added 

VERSION  1.51 
� Uses PLE.HLP as the Help file 
� Will use Hercules Graphics card 
� Stand alone version displays colours in Help correctly 

VERSION  1.5  
� Use PPD.EXE instead of PRINTGL 
� Can be called from PLE.EXE (PLESPACE.INI automatically set up) 
� Released with version 4.77 of Perfect Lite 
� PPD.EXE outputs to DOS LPT? not BIOS LPT? (fixes bug with network printers) 
� Uses PLE47.INI for configuration options 

VERSION  1.4 
� NON Intel co-processor problem fixed 

VERSION  1.3 
� Program corrected for when no solution found for a particular road width 
� Thickness added to printer output 

VERSION  1.2 
� PRINTGL used for graphics printer output 

VERSION  1.1 
� Minor changes only 

VERSION  1.0  (Released 1990) 
� Original issue 

 
 


